Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, MediaShow IS PROVIDED “AS IS;” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH MediaShow AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT.

BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

MediaShow is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

International Headquarters

Mailing Address
CyberLink Corporation
15F, #100, Minchiuan Road, Shindian City
Taipei 231, Taiwan

Web Site
www.cyberlink.com

Telephone
886-2-8667-1298

Fax
886-2-8667-1300

Copyright © 2008 CyberLink Corporation. All rights reserved.
Contents

CyberLink MediaShow ......................... 1
Welcome ......................................................... 2
The CyberLink MediaShow Program .............. 3
  Library ......................................................... 4
  Media Window ........................................... 9
  Tray .......................................................... 10
  Favorites .................................................... 10
  View Preferences ....................................... 11
System Requirements ................................ 12

Photos ....................................................... 15
Viewing Photos .......................................... 16
  Viewing a Single Photo ............................. 16
  Creating a Photo Slideshow ....................... 17
Editing Photos .......................................... 19
  Photo Fixes ............................................... 20
  Fine Tune Photos ...................................... 21
  Photo Effects ............................................ 21
  Photo Description, Info and Tags ............... 22
  Batch Edit .................................................. 22
Printing Photos .......................................... 23
  Printing Photos on a Printer ....................... 23
  Ordering Photo Prints ............................... 24
Creating Media with Your Photos .................. 25
  Setting a Photo as Desktop Background ....... 25
  Creating a Screen Saver ............................ 25
  Creating a Slideshow Movie ..................... 26
  Creating a Disc .......................................... 27
Sharing Your Photos .................................... 28
  E-mailing Photos ...................................... 28
  Uploading Photos to Flickr ....................... 28
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Videos</strong></td>
<td>31</td>
</tr>
<tr>
<td>Watching Your Videos</td>
<td>32</td>
</tr>
<tr>
<td>Watching Videos</td>
<td>32</td>
</tr>
<tr>
<td>Editing Your Videos</td>
<td>35</td>
</tr>
<tr>
<td>Video Fixes</td>
<td>36</td>
</tr>
<tr>
<td>Fine Tune Videos</td>
<td>36</td>
</tr>
<tr>
<td>Trim Videos</td>
<td>36</td>
</tr>
<tr>
<td>Video Description, Info and Tags</td>
<td>37</td>
</tr>
<tr>
<td>Creating Media with Your Videos</td>
<td>38</td>
</tr>
<tr>
<td>Creating Movies</td>
<td>38</td>
</tr>
<tr>
<td>Creating a Disc</td>
<td>40</td>
</tr>
<tr>
<td>Sharing Your Videos</td>
<td>41</td>
</tr>
<tr>
<td>E-mailing Videos</td>
<td>41</td>
</tr>
<tr>
<td>Uploading Videos to YouTube</td>
<td>41</td>
</tr>
<tr>
<td><strong>Create Disc</strong></td>
<td>43</td>
</tr>
<tr>
<td>Creating a New Disc</td>
<td>44</td>
</tr>
<tr>
<td>Create Disc Window</td>
<td>45</td>
</tr>
<tr>
<td>Step 1 - Inputting Your Title</td>
<td>45</td>
</tr>
<tr>
<td>Step 2 - Selecting a Style</td>
<td>46</td>
</tr>
<tr>
<td>Step 3 - Adding Videos</td>
<td>46</td>
</tr>
<tr>
<td>Step 4 - Adding Photos</td>
<td>46</td>
</tr>
<tr>
<td>Step 5 - Burning Your Disc</td>
<td>47</td>
</tr>
<tr>
<td>Saving and Opening Existing Disc Projects</td>
<td>47</td>
</tr>
<tr>
<td>Create Disc Settings</td>
<td>48</td>
</tr>
<tr>
<td><strong>Preferences</strong></td>
<td>51</td>
</tr>
<tr>
<td>MediaShow Preferences</td>
<td>52</td>
</tr>
<tr>
<td>General Preferences</td>
<td>52</td>
</tr>
<tr>
<td>E-mail Preferences</td>
<td>52</td>
</tr>
<tr>
<td>Slideshow Preferences</td>
<td>53</td>
</tr>
<tr>
<td>Screen Saver Preferences</td>
<td>53</td>
</tr>
<tr>
<td>Library Preferences</td>
<td>54</td>
</tr>
</tbody>
</table>
Technical Support ........................................ 57
Before Contacting Technical Support ............................................. 58
Web Support ..................................................................................... 59

Index ............................................................................................... 61
Chapter 1:

**CyberLink MediaShow**

This chapter introduces CyberLink MediaShow and provides an overview of the Library and the Media Window. It also outlines the minimum system requirements for using the program.

This chapter contains the following sections:

- "Welcome" on page 2
- "The CyberLink MediaShow Program" on page 3
- "System Requirements" on page 12
Welcome

Welcome to the CyberLink family of software programs. CyberLink MediaShow is a new and innovative way to view and be creative with your media.

CyberLink MediaShow lets you be as imaginative as you want by performing the following functions:

- View your photos and videos
- Edit and add effects to your photos and videos
- Create screen savers and slideshows with your photos
- Create stylish and professional looking movies with your videos
- Upload your videos directly to YouTube
- Upload your photos directly to Flickr
- E-mail photos and videos directly from CyberLink MediaShow to your friends
- Create discs with your photos and videos in the DVD or Blu-ray Disc format, including AVCHD discs.
The CyberLink MediaShow Program

CyberLink MediaShow has three main modules: the Photo, Video and Create Disc modules. When you open the Photo or Video module, the program appears as follows:

**Function buttons**
Perform a variety of useful functions instantly

**Tray**
Hold the media you want to view in a slideshow, burn to a disc and more

**Library**
Conveniently organizes all of your media files by album, folder and tags

**Media Window**
Contains resizable thumbnails for all the imported media

**Note:** Use the **To Photo/To Video** button within the **Home** menu to switch between to two main modules.
The Library is a convenient way to organize and keep track of all your media. When you import your media, CyberLink MediaShow categorizes all of it into a series of folders for easy browsing.

CyberLink MediaShow will scan the folders in your Library for new media every time the program is launched. For information on adding new folders to the Library, see "Library Preferences" on page 54.

The Library consists of the following sections:

- **Albums**
- **Folders**
- **Tags**
Chapter 1: CyberLink MediaShow

Albums

The Albums section is a grouping of your media that you can create, helping you organize your media and prepare it for creating slideshows, discs, etc. Also, whenever you add media to your Favorites, it will be placed in the Favorite Media folder in albums automatically.

Use the Album Tools on the CyberLink MediaShow menu bar to:

- Add a New album.
- Edit existing album information.
- Sort by date, name or file size.
- Delete an album from the Library.

You may also create a new album by doing one of the following:

- Right-click within the albums section and select Create a new album.
- Click on the Create a new album button.
- Right-click on an item in media window and select Add to Album > Create a new album.

Once you select Create a new album, enter in a name and description of the album in the window that open.

To add media to an album, do this:

- right-click on the media and select Add to Album and then select the album you want to add it to.
- drag and drop your media into the album you want to add it to in the Library.

Note: See "Favorites" on page 10 for information on the Favorite Media album and "Creating a Screen Saver" on page 25 for information on the Screen Saver album.

Folders

The Folders section is a listing of the folders that were imported into CyberLink MediaShow. The folders contain all of your photos and videos, which are organized by year for easy browsing.
**Note:** Media located on removable drives and optical discs will not be displayed in the folder list.

Use the **Folders Tools** on the CyberLink MediaShow menu bar to:

- **Edit** existing folder information.
- **Sort by** date, name or file size.
- **Locate** the folder on your hard disk.
- **Delete** a folder and its contents from your computer’s hard drive.
- **Hide** a folder in from view within the Library.

You can also edit your folder information by right-clicking on a folder in the Library or Media Window and selecting **Edit Folder Information**.

Sort the media within a folder by right-clicking in the Library and selecting **Sort by**.

You can create new folders within the Library via one of the following methods:

- Right-click on a folder and select **Separate by Date** to create a series of new folders based on file date.
- Right-click on a media file within a folder and select **Separate Folder Here**. CyberLink MediaShow will create a new folder that includes the media from the position where you clicked.
- Select one or more media files, right click and then select **Move to New Folder** to create a new folder containing the selected media.

**Tags**

Tags can be added to your photos and videos to make it easier to search for specific media later. Tags are also useful when uploading media to Flickr and YouTube, as users search by tags to find videos and photos they are interested in.

Use the **Tag Tools** on the CyberLink MediaShow menu bar to:

- Add a **New** tag.
- **Edit** an existing tag.
- **Sort by** date, name or file size.
• **Delete** a tag.

To create a new tag, do one of the following:

• Click on the **Add a new tag** button.
• Right-click on the Tags section and select **Add a New Tag**.
• Drag and drop your media into the Tags section in the Library.
• Right-click on an item in the media window and select **Add Tag > Add a new tag**.

Once you select **Add a New Tag**, enter in a name and description of the tag in the window that opens.

**Note:** More than one tag can be added to a single photo or video.

### Importing Media into the Library

When you first launch CyberLink MediaShow you will be guided through a wizard that assists with the import of your photos and videos.

If there is some media that was missed, was added after the original import or you have media on an external/removable device, you can use the Import window to import it into CyberLink MediaShow.

To import media into CyberLink MediaShow, do this:

1. Click the **Import** button. The Import window will be displayed.
2. In the Source panel, click the **Select Source** drop-down menu and then select:
   • the source you want to import from if displayed.
   • **Browse** to select a specific folder or device in the Browse for Folder window.

   **Note:** You may also drag and drop photos and videos into the CyberLink MediaShow window to import them into the program.

3. Click **OK**. The contents of the folder will be displayed in the Source window.
4. Click **Import All** to import all the media in the specified folder or select the specific media you want and then click **Import Selected**.
Note: Selecting the **Exclude duplicates** option will make CyberLink MediaShow ignore the media files that have already been imported into the Library.

5. Enter the required information into the **Imported Folder Information** window and then click on **OK**.

6. Click on **Done** when the import is complete and then click on **Back** to return to CyberLink MediaShow’s main window.
Media Window

The Media Window contains thumbnails of all the media that has been imported into CyberLink MediaShow.

There are several options available to you within the Media Window. Right-click on a photo or video for a listing of available functions.

You may dynamically resize the thumbnails in the Media Window by:
• using the slider in the bottom right corner of the window.

• selecting View > Thumbnails and then select the desired size.

Searching for Media

If you are in the situation where you cannot find a specific media file or folder in the Media Window, you can use the Search function to assist in your search.

Simply type in a search keyword in the search field located in the top right of the program window, and CyberLink MediaShow will filter the media files within the Media window based on the keyword.

Tray

The Tray is a convenient little area that lets you hold the media you want to add to an album, view in a slideshow, include on a disc, etc.

When you are browsing through your media within different folders in the Media Window, clicking on a photo or video will display a thumbnail of it in the Tray.

If you would like to hold a photo or video in the Tray for future use, click on Hold. The item will be held in the Tray until you select it and click on the Clear button.

Favorites

CyberLink MediaShow lets you add the photos and videos you like the most to your Favorites. When you add media to your Favorites, it will be added to the Favorite Media folder in Albums, where you can easily view them or add them to a disc.

To add media to your Favorites, do one of the following:
• select the media files you want to add in the Media Window and then click on the Favorites button.
• while viewing media click on the Favorites button.
• drag and drop media into the Favorite Media folder in Albums.

View Preferences

CyberLink MediaShow provides you with some viewing preferences so you can customize the program to your liking. Click on View within CyberLink MediaShow to customize the following options:

• **Thumbnails**: select the size of the thumbnails that are displayed in the Media Window.
• **Captions**: select the type of caption that will be displayed underneath your media in the Media Window.
• **Skin**: select the color of the user interface skin for CyberLink MediaShow.
• **Display Hidden**: use this option to display media and folders that were previously hidden from view within CyberLink MediaShow.
System Requirements

The system requirements listed below are recommended as minimums for running CyberLink MediaShow.

<table>
<thead>
<tr>
<th>Minimum System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OS</strong></td>
</tr>
<tr>
<td>• Windows 7/Vista/XP (Service Pack 2)</td>
</tr>
<tr>
<td>• DirectX 9 or above</td>
</tr>
<tr>
<td><strong>Screen Resolution</strong></td>
</tr>
<tr>
<td>• 800 X 600, 16-bit color or above</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
</tr>
<tr>
<td>• 512MB required (1GB above recommended, 2GB above recommended for HD video)</td>
</tr>
<tr>
<td><strong>HDD Space</strong></td>
</tr>
<tr>
<td>• 1GB required</td>
</tr>
<tr>
<td>• 10GB (20GB recommended) required for DVD production</td>
</tr>
<tr>
<td>• 60 GB (100 GB recommended) for Blu-ray Disc production</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
</tr>
<tr>
<td>• Intel Pentium D 3.0 Ghz CPU with hyperthreading or equivalent AMD CPU is minimal</td>
</tr>
<tr>
<td>• High Quality MPEG-4 and WMV, QuickTime, RealVideo Profiles: Pentium 4 2.4 GHz or AMD Athlon XP 2400+</td>
</tr>
<tr>
<td>• AVCHD and MPEG-2 HD Profiles: Pentium Core 2 Duo E6400 or Athlon 64 X2 5000+</td>
</tr>
<tr>
<td>• CyberLink MediaShow 4 is optimized for CPU with MMX/SSE/SSE2/3DNow!/3DNow! Extension/HyperThreading/Dual Core technology</td>
</tr>
</tbody>
</table>
## Minimum System Requirements

**VGA**
- Minimum Intel 945GM above
- Minimum Nvidia GeForce 6600 above
- Minimum ATI X1600 above
- 64MB-VRAM or above
- Some animation effects may be turned off or degraded for lower end graphics system

**Burning Device**
- A DVD burner (DVD+R/RW or DVD-R/RW) is required to burn DVD/AVCHD contents
- A Blu-ray disc recordable drive is required to burn Blu-ray discs

**Printers**
- All printers

**Internet Connection**
- An Internet connection is required for some upload/download features

**Import Devices**
- Cameras via removable disk interface
- Cameras support Windows Portable Devices interface
- CDV devices via 1394
Chapter 2:

Photos

This chapter guides you through the different creative functions you can perform with your photos in CyberLink MediaShow. It also outlines the various editing functions and the process of e-mailing and uploading your photos to Flickr.

This chapter contains the following sections:

- "Viewing Photos" on page 16
- "Editing Photos" on page 19
- "Printing Photos" on page 23
- "Creating Media with Your Photos" on page 25
- "Sharing Your Photos" on page 28
Viewing Photos

You can use CyberLink MediaShow to view your photos, like viewing photos in an album or a scrapbook. To launch the Photo module, select the **Photo** button on the CyberLink MediaShow launcher.

**Note:** You can also launch the Photo module from within the Video module by clicking on the **To Photo** button.

Viewing a Single Photo

You can quickly view any photo that is displayed in the Library by double-clicking on it in the Media window. Use the slider on the right of the slideshow playback controls to dynamically resize the photo to the desired size.
Creating a Photo Slideshow

CyberLink MediaShow lets you instantly create a photo slideshow with your photos. You can select from a number of effects, add background music, and then output it to a disc later.

You can instantly create a slideshow with your photos by:

- selecting an album, folder or tag and then clicking the Slideshow button. CyberLink MediaShow will display all the photos in the album, folder or with that tag in the slideshow.
- double-clicking on a photo or selecting a photo in an album/folder/tag and then clicking the Slideshow button. CyberLink MediaShow will display all the photos in the album/folder or with the same tag in the slideshow.
- selecting multiple photos in various folders and albums, and then clicking the Slideshow button. CyberLink MediaShow will display a slideshow of all the photos that are currently within the Tray as result of being selected or held.

Slideshow Controls

When viewing a slideshow, the following controls are available, providing you with the following options:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>😞</td>
<td>Stops the slideshow and returns to the main Photo window.</td>
</tr>
<tr>
<td>🌟</td>
<td>Click this button to select the desired effect for your slideshow. See &quot;Slideshow Preferences&quot; on page 53 for a detailed description of the slideshow styles.</td>
</tr>
<tr>
<td>Button</td>
<td>Function</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
</tr>
<tr>
<td><img src="image" alt="Clock" /></td>
<td>Click this button to configure your slideshow settings. You can select the slideshow speed and whether you want to <strong>Show Captions</strong> during the slideshow. Select <strong>Loop</strong> for continuous playback of the slideshow and <strong>Shuffle</strong> to display the photos in random order. Click <strong>Select Background Music</strong> to select a song to use as background music and <strong>Match to Background Music Length</strong> to set the slideshow duration to match the length of the music selected.</td>
</tr>
<tr>
<td><img src="image" alt="Previous" /></td>
<td>Returns to the previously viewed photo.</td>
</tr>
<tr>
<td><img src="image" alt="Play" /></td>
<td>Starts the playback of the slideshow.</td>
</tr>
<tr>
<td><img src="image" alt="Pause" /></td>
<td>Pauses the playback of the slideshow.</td>
</tr>
<tr>
<td><img src="image" alt="Next" /></td>
<td>Jumps to the next photo in the slideshow.</td>
</tr>
<tr>
<td><img src="image" alt="Favorites" /></td>
<td>Click the <strong>Favorites</strong> button to add or remove the current photo in a slideshow to your favorites.</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Left" /></td>
<td>Click this button to rotate the current photo left.</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Right" /></td>
<td>Click this button to rotate the current photo right.</td>
</tr>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>Click this button to open the Edit window and edit the currently displayed photo. See &quot;Editing Photos&quot; on page 19 for more information.</td>
</tr>
<tr>
<td><img src="image" alt="Volume" /></td>
<td>Click this button to adjust the background music’s volume.</td>
</tr>
</tbody>
</table>
Editing Photos

CyberLink MediaShow offers several editing features, including adding creative effects to your photos or performing various touch ups in preparation for slideshows and discs.

**Note:** Any edits that you make to a photo can always be undone and the photo can easily be restored to the original version by right-clicking on it in the Media window and selecting **Undo Changes**.

Use the **Compare** feature for a better view of the changes you make to your photos.

To open the Edit Photos window:

- select a folder, album, tag or multiple photos and then click on the **Edit** button.
- right-click on a photo and then select **Edit**
**Note:** Any photos that are currently being held in the Tray, will also be available in the Edit window.

Click the **Rotate Left** or **Rotate Right** button to adjust a photos orientation at any time. This function may also be performed in the Media window. To resize the viewing size of a photo, click:

- ![Actual Size](image)
- ![Fit](image)
- ![Full Screen](image)
- Use the slider on the bottom right to dynamically resize the photo to the desired size.

**Photo Fixes**

CyberLink MediaShow provides you with several commonly required quick fixes for your photos, including automatic fixes, fixing red-eye and a photo cropping feature. Click on the **Fix** button to open the Photo Fixes window.

- **Crop**: allows you to crop the photo and cut out the portions you don’t want. Select a **Fixed ratio** to crop a specified size out of the photo.
- **Red-eye**: use this option to remove unwanted red-eye from your photos.
- **Straighten**: if your photo was taken unevenly and appears to be crooked, select this option to make it more level.
- **Auto Brightness**: click the **Auto Brightness** button to automatically adjust the photo’s brightness.
- **Auto Contrast**: click the **Auto Contrast** button to automatically adjust the photo’s contrast.
- **Auto Balance**: click the **Auto Balance** button to automatically adjust the photo’s color balance.
- **Auto Fix Lighting**: click the **Auto Fix Lighting** button to automatically fix the lighting within the photo.
Fine Tune Photos

Use the Fine Tune function if you want to manually adjust the Brightness, Contrast, Saturation, White balance or Sharpness of your photos. To manually adjust your photo’s properties, click on Fine Tune and then use the relevant sliders to adjust the properties.

Photo Effects

CyberLink MediaShow lets you add display and color effects to your photos. Click on the Effects button to open the Photo Effects window.

- **Black & White**: Changes color photos into black and white photos.
- **Sepia**: Applies a dark brown-grey hue that resembles the effect of aging in old photographs.
- **Matte**: Adds a white matting to your photo. Click and drag the focus to the area you want to apply the matting, and then use the slider to increase or decrease its size.
- **Vignette**: Using the slider closes/opens a black circle on your photo, like in old silent movies.
- **Soft Focus**: Adds a soft focus effect to your photo. Use the Size slider to adjust the focus area and the Soft slider to adjust the amount of blur.
- **Focal B&W**: The focal black and white effect lets you have some portions of a photo in color, while others are in black and white. Use the slider to adjust the area that you want to display color.
- **Tint**: The tint effect lets you add highlighted color throughout your photo. Pick your desired color and then use the slider to adjust the intensity.
- **Glow**: The glow effect makes all the lighter areas of a photo appear to glow.
- **Antique**: The antique effect gives your photo an old fashioned look, as if it was taken more than 50 years ago.
Photo Description, Info and Tags

CyberLink MediaShow also lets you add descriptions and tags to your photos, as well as view detailed information about a photo.

- To add a caption description to your photo click the **Description** button 📄 or click and type in the space below the photo.
- To view detailed information about a photo, click on the **Info** button.
- To add a tag to a photo, click on the **Tags** button. See "Tags" on page 6 for more information.

Batch Edit

The **Batch Edit** function is available in the main Photo window. Select multiple photos and then select the desired edit function from the **Batch Edit** drop-down to apply the edit to all the items.
Printing Photos

With CyberLink MediaShow you can print out your photos on your printer in a variety of sizes or send them directly to an online printing service.

Printing Photos on a Printer

CyberLink MediaShow lets you print out copies of your photos in a variety of sizes, acting like a virtual dark room.

To print photos, do this:

1. Select and **Hold** (in the Tray) all of the photos that you want to print and then click on **Print**. The Print window will be displayed.
2. Set your printing options as follows:
   - **Layout**: select how you want the selected photos printed out. You can select from a variety of sizes, allowing you to print one or more photos out on a single piece of paper.
   - **Printer**: select the printer from the drop down menu that you want to print your photos out on.
   - **Fit**: select whether to shrink the size of the photo to fit the printing area or have CyberLink MediaShow automatically crop the photo to fit it.
   - **Printer Setup**: click this button to set specific printer options, such as page layout and whether you want to print double-sided. The options available depend on the printer that is connected.
   - **No. of copies per photo**: enter the number of copies for each photo you would like printed out in the field provided.
3. Click on the **Print** button to begin printing your photos.

Ordering Photo Prints

You can send your photos from within CyberLink MediaShow directly to an online provider to order prints and other products.
To order prints from an online provider, do this:

1. Select and **Hold** (in the Tray) all of the photos that you want to send and then click on **Order Prints**.
2. Select the online provider from the list that you want to use.
3. After completing the authorization process and uploading your photos to the online provider, go to its web site and complete your order as desired.
Creating Media with Your Photos

CyberLink MediaShow lets you create several types of media with your photos, including screen savers and slideshow videos that can be burned to a disc. To begin creating media with your photos, click on Create in the main Photo window.

Setting a Photo as Desktop Background

You can set any of the photos in your Library as your desktop background. To do this:

1. Click on the photo in your Library that you want to add as your desktop background.
2. Click the Desktop button.
3. Select whether to center, tile or stretch it on your desktop. The selected photo will be set as the desktop background.

Creating a Screen Saver

CyberLink MediaShow lets you create a screen saver with your photos. To create a screen saver, do this:

1. Select and Hold (in the Tray) all the photos in your Library that you want to include in your screen saver.
2. Click on the Screen Saver button.
3. Click the Yes button. CyberLink MediaShow will create your screen saver and set it as your default screen saver.
Note: CyberLink MediaShow places the photos in the Screen Saver album within Albums. You can instantly add new photos to the screen saver by dragging and dropping them here.

To modify the preferences for your created screen saver, including the addition of background music, see "Screen Saver Preferences" on page 53.

Creating a Slideshow Movie

You can create a slideshow movie file in the WMV or MPEG-2 format, which can be burned to a disc, e-mailed to friends or uploaded to the Internet.

To create a slideshow movie, do this:

1. Select and Hold (in the Tray) all the photos in your Library that you want to include in your slideshow movie.
2. Click on the Movie button. The Output Settings window will be displayed.
3. Within the Slideshow style window:
   - **Style**: select the style for your slideshow movie. See "Slideshow Preferences" on page 53 for a detailed description of the slideshow styles.
   - **Speed**: select the speed of your slideshow movie, or how quickly the slideshow will advance to the next photo.
4. Within the Slideshow background music window:
   - **Play music during slideshow**: select this option to include background music in your slideshow movie.
   - **Change slideshow length to match music**: select this option to make the duration of the slideshow match the music selected as the background music.
   - **Set folder or select a file as background music**: select this option to select a specific audio file or a whole folder that contains music as the background music.
   - **Select and arrange background music**: select this option to completely customize the background music in your slideshow.
movie. Use the Add music files button to add songs to the list and then set the order using Move selection up and Move selection down.

5. Within the Movie output options window:
   - **Movie format**: select the format of the outputted movie file, either WMV or MPEG-2.
   - **Movie size**: select the size of the outputted movie, based on your intended purpose.
   - **Save movie to**: select the folder where you want the created movie to be saved.

6. Click on Create to begin creating your slideshow movie file. The created movie will be saved and added into the Library in the Video window.

**Creating a Disc**

You can create a disc that contains your photos from the Library. To do this, select and Hold (in the Tray) all the photos in your Library that you want to include on your disc and then click on the Disc button.

See "Create Disc" on page 43 for detailed information on creating a disc with your photos.
CyberLink MediaShow lets you e-mail photos or upload them to Flickr so you can share them with your friends, family or the world. To do this, select **Share** on the main Photo window.

### E-mailing Photos

You can e-mail one or more photos in the Library to your friends and family from within CyberLink MediaShow.

To e-mail photos to your friends from within CyberLink MediaShow, do this:

1. Select and **Hold** (in the Tray) all the photos in your Library that you want to e-mail.
2. Click on the **E-mail** button. CyberLink MediaShow will automatically launch your default mail client and attach the photos to an e-mail message.

   **Note:** If your computer does not have a default mail client configured, the e-mail feature may not work from within CyberLink MediaShow.

3. Proceed to complete the sending of the e-mail as required.

   **Note:** For information on configuring the settings for e-mailing photos and videos, see "E-mail Preferences" on page 52.

### Uploading Photos to Flickr

You can upload photos from the Library within CyberLink MediaShow directly to the Flickr photo sharing web service.

To upload a photos to Flickr, do this:

1. Select and **Hold** (in the Tray) all the photos in your Library that you want to upload to Flickr.
2. Click on the Flickr button. The Upload to Flickr wizard will be displayed.

3. To authorize CyberLink MediaShow to upload photos to Flickr click on the Authorize button.

   **Note:** If you do not have a Flickr account, you must register first before proceeding with the authorization.

4. Click the Continue button to proceed and then configure the photo upload settings as follows:
   - **Resize:** To resize your photos to a specific size before uploading, select *Always resize the largest file to* and then select the size from the drop down menu.
   - **Privacy:** Select whether to mark your photos as Private (viewed by only friends, family or both) or Public.

5. Click Upload to begin uploading your photos to Flickr. Click the Done button once your photos has been uploaded.
Chapter 3:

Videos

This chapter guides you through the different creative functions you can perform with your videos in CyberLink MediaShow. It also outlines the various editing functions and the process of e-mailing or uploading your photos to YouTube.

This chapter contains the following sections:

- "Watching Your Videos" on page 32
- "Editing Your Videos" on page 35
- "Creating Media with Your Videos" on page 38
- "Sharing Your Videos" on page 41
Watching Your Videos

You can use CyberLink MediaShow to watch your videos, like your own personal screening room. To launch the Video module, select the **Video** button on the CyberLink MediaShow launcher.

![CyberLink MediaShow Welcome](image)

**Note:** You can also launch the Video module from within the Photo module by clicking on the **To Video** button.

Watching Videos

You can quickly watch a video file that is in the Library by double-clicking on it in the Media window or selecting multiple videos and then clicking the **Play** button. Use the slider on the right of the playback controls to dynamically resize the video to the desired size.
# Playback Controls

When watching a video, the following playback controls are available, providing you with the following options:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎬</td>
<td>Stops the video and returns to the main Video window.</td>
</tr>
<tr>
<td>⏯️</td>
<td>Click this button to configure the playback settings. You can select the speed of the video playback and whether you want to <strong>Show Captions</strong> during playback. Select <strong>Loop</strong> for continuous playback of the video and <strong>Shuffle</strong> to play the videos in the folder in random order.</td>
</tr>
<tr>
<td>⏪</td>
<td>Returns to the previously played video, if available.</td>
</tr>
<tr>
<td>🖤</td>
<td>Starts the playback of the video.</td>
</tr>
<tr>
<td>✯</td>
<td>Pauses the playback of the video.</td>
</tr>
<tr>
<td>⏩</td>
<td>Jumps to the next video in the folder.</td>
</tr>
<tr>
<td>⭐️</td>
<td>Click the favorites button to add or remove the current video to your favorites.</td>
</tr>
<tr>
<td>⚙️</td>
<td>Click this button to rotate the current video left.</td>
</tr>
<tr>
<td>⚙️</td>
<td>Click this button to rotate the current video right.</td>
</tr>
</tbody>
</table>
Click this button to open the Edit window and edit the video. See "Editing Your Videos" on page 35 for more information.

Click this button to adjust the video’s volume.
Editing Your Videos

CyberLink MediaShow provides several editing features, including video trim and adding touch ups in preparation for burning them to disc.

To open the Edit Videos window:

- select a folder, album, tag or multiple videos and then click on the **Edit** button.
- right-click on a video and then select **Edit**.

**Note:** Any videos that are currently being held in the **Tray**, will also be available in the Edit window.

Click the **Rotate Left** or the **Rotate Right** button to adjust a video's orientation at any time. This function may also be performed in the Media window. To resize the playback size of a video, click:
• 
• 
• 
• Use the slider on the bottom right to dynamically resize the video to the desired size.

Video Fixes

CyberLink MediaShow provides you with several common required quick fixes for your videos, including automatic fixes and a video stabilizer feature. Click on the Fix button to open the Video Fixes window.

• **Fix Shaky Video**: select this option to automatically correct shaky video.
• **Auto Fix Lighting**: select this option to automatically fix the lighting within the video.
• **Reduce Background Noise**: use this option to filter out background noise from the audio track. Drag the slider to remove more or less noise.

Fine Tune Videos

Use the Fine Tune function if you want to manually adjust the **Brightness**, **Contrast**, **Saturation** or **White balance** of your videos. To manually adjust your video’s properties, click on **Fine Tune** and then use the relevant sliders to adjust the properties.

Trim Videos

Use the **Trim** function to cut out the portions of the video that you don’t want in your final video. Use the **Mark In/Mark Out** buttons to
select a scene you want to keep or remove, and then select the appropriate button.

**Video Description, Info and Tags**

CyberLink MediaShow also lets you add descriptions and tags to your videos, as well as view detailed information about a video.

- To add a caption description to your video click the **Description** button or click and type in the space below the video.
- To view detailed information about a particular video, click on the **Info** button.
- To add a tag to a video, click on the **Tags** button. See "Tags" on page 6 for more information.
Creating Media with Your Videos

CyberLink MediaShow lets you create stylish movies with your videos, which can then be burned to a disc. To begin creating movies with your videos, click on Create in the main Video window.

Creating Movies

With the Create Movie function, you step into the editing room and create a finished movie with your videos. You can select from a number of pre-defined movie styles, perform trims on video clips and mix in music with your movie.

To create a movie, do this:

1. Select and **Hold** (in the Tray) all the videos in your Library that you want to include in your movie and then click **Movie**. The Create Movie window will be displayed.

   **Note:** You may add additional video clips to your movie from within the Create Movie window by clicking on the **Add** button in the video clip panel.

2. The following available creative functions within the Create Movie window are as follows:
   - Click on **Style** to select a movie style template that fits your video. Selecting a style template provides pre-designed opening sequences, transitions and effects to automatically generate professional-looking movie.
   - Click on **Trim** to remove any unwanted scenes from your video clips. Use the playback controls to find the scenes and the **Mark In/Mark Out** buttons to select scenes you want to keep or remove. Select the appropriate button to keep or remove the selected scene.
Chapter 3: Videos

- Click on **Mix** and then on + to add background music to your movie. Use the **Sound mix** slider to set the audio level between the added background music and the video’s original audio.

3. Click on the **Movie** button next to the playback controls to generate or preview a version of the finished movie.

   **Note:** CyberLink MediaShow will generate a new version of the movie every time any of the noted functions are changed.

4. When you are satisfied with your movie, click the **Produce Movie** button to output a finished version to a video file. The finished movie will be produced and saved in your Library.

   **Note:** Before you produce you movie, it is recommended that you configure its output settings in **Movie Settings**.

**Movie Settings**

Movie Settings lets you input your movie’s title, set the size of the movie, select the output file format and more. It is recommended that you configure these settings before you produce your final movie.

Select **Settings** within the Create Movie window and configure the settings as follows:

- **Title**: input a title for your movie, which will be displayed during the opening.
- **Credits 1, Credits 2**: input text you want to use as part of your movie’s closing credits, for example your name or date created.
- **Movie size**: select the desired size of the outputted movie file. The larger size that you select, the better quality of the outputted video. Select **Auto** to have CyberLink MediaShow select the file size automatically.
- **Aspect ratio**: select the aspect ratio for your movie based on the aspect ratio of the original video clips. Select **Auto** to have CyberLink MediaShow select the aspect ratio automatically.
- **Format**: select the file format of the outputted movie.
Creating a Disc

You can create a disc that contains your videos from the Library. To do this, select and Hold (in the Tray) all the videos in your Library that you want to include on your disc and then click on the Disc button.

See "Create Disc" on page 43 for detailed information on creating a disc with your photos.
Sharing Your Videos

CyberLink MediaShow lets you e-mail videos or upload them to YouTube so you can share them with your friends, family or the world. To do this, select Share on the main Video window.

E-mailing Videos

You can e-mail one or more videos in the Library to your friends and family from within CyberLink MediaShow.

Note: The maximum size the file that you can e-mail depends on the attachment limitations of your e-mail provider.

To e-mail videos to your friends from within CyberLink MediaShow, do this:

1. Select and Hold (in the Tray) all the videos in your Library that you want to e-mail.
2. Click on the E-mail button. CyberLink MediaShow will automatically launch your default mail client and attach the videos to the e-mail.

Note: If your computer does not have a default mail client configured, the e-mail feature may not work from within CyberLink MediaShow.

3. Proceed to complete the sending of the e-mail as required.

Uploading Videos to YouTube

You can upload videos from the Library within CyberLink MediaShow directly to the YouTube video sharing web service.

To upload a your videos to YouTube, do this:

1. Click on the video in the Media window that you want to upload to YouTube.
2. Click on the **YouTube** button. The Upload to YouTube wizard will be displayed.

3. To authorize CyberLink MediaShow to upload videos to YouTube click on the **Authorize** button.

   **Note:** If you do not have a YouTube account, you can register first before proceeding with the authorization.

4. Click the **Next** button to proceed and then configure the video upload settings as follows:

   - **Video category**: select the relevant video category type from the available list.
   - **Broadcast options**: select whether to share your video with the world by marking it public or mark it as private.

5. Click the **Upload** button to begin uploading your video to YouTube. Click the **Done** button once your video has been uploaded.
Chapter 4:

Create Disc

This chapter takes you through the process of creating professional looking discs with themes and menus, using your videos and photos. It also outlines the configuration for your burning settings.

This chapter contains the following sections:

- "Creating a New Disc" on page 44
- "Create Disc Settings" on page 48
Creating a New Disc

You can use CyberLink MediaShow to create professional looking discs that contain your photos and videos. To launch the Create Disc module, select the Create Disc button on the CyberLink MediaShow launcher.

Note: If enabled within the Create Disc Settings, CyberLink MediaShow will ask you to select the format for your disc when you launch the Create Disc window. For more information on the specific formats, see "Create Disc Settings" on page 48.
Create Disc Window

The Create Disc window provides you with an easy to use wizard that will guide you through the creation of your disc.

Note: Before you begin creating your disc, you may want to configure your Create Disc settings. See "Create Disc Settings" on page 48 for more information.

Step 1 - Inputting Your Title

The title field allows you to enter a title description for your disc that will be displayed on the main menu page. Simply input your desired title in the field provided.
Step 2 - Selecting a Style

CyberLink MediaShow provides you with the option of selecting from a number of several stylish predefined disc menus. These menus have already been customized for you and may include such features as motion and menu music.

The pre-defined menu templates create menus with either clickable menu text or clickable thumbnails, depending on the template you selected. Some menus in CyberLink MediaShow are also pre-designed to be multi-layered. These menus consist of a main menu home page with text links to the sub menu containing your movie productions.

Step 3 - Adding Videos

If required, you can add your videos to your disc creation in Step 3. To do this:

1. Click on the Video tab on the left of the window.
2. Browse through your Library folders and select all the videos you want to include on your disc.
3. Either drag and drop them into the Videos section or use the Add buttons.

Step 4 - Adding Photos

If required, you can add your photos to your disc creation in Step 3. To do this:

1. Click on the Photo tab on the left of the window.
2. Browse through your Library folders and select all the photos you want to include on your disc.
3. Either drag and drop them into the Photos section or use the Add buttons.
4. Click the Style & Music button to customize your slideshow as follows:
• **Slideshow Style:** Select one of the following slideshow styles from the drop down menu: **Fading, Motion, Cell** (see the Slideshow Style section in "Slideshow Preferences" on page 53 for a detailed description of the each slideshow style). Select the **Speed** the pictures in the slideshow will be displayed from the drop down menu.

• **Background music:** Select **Play music during slideshow** to include background music in your slideshow. Select **Change the slideshow length to match music** for the duration to match the total length of the specified background music. Choose **Set folder or select a file as background music** or **Select and arrange background music**, depending on your preference. The first option lets you select a single song or folder containing music, while the second option gives you more customizable options.

5. Click on **OK** to return to the Create Disc window.

---

**Step 5 - Burning Your Disc**

The final step for your production is to click the **Burn** button to begin burning your media to disc. Before you do this however, be sure to use the **Preview** function to ensure your disc is exactly the way you want it.

**Saving and Opening Existing Disc Projects**

When you are creating your disc, you don’t need to finish your creation all in one sitting. At any time you can **Save** your disc project and then **Open** it and finalize it at later date.
Create Disc Settings

Before you burn your created disc, you may want to configure the disc settings. To do this, click on **Settings** in the Create Disc window and then configure the settings as follows:

**Disc Details**

- **Disc format**: select the format of your disc. Your selection may be based on the type of burning device you have installed in your computer. **DVD**: creates a standard DVD disc; **ACVHD**: to create a high-quality high definition video that uses the MPEG-4 AVC (H.264) video codec and is burned to a DVD disc; **Blu-ray Disc**: to create a high-quality high definition video that will play back on a Blu-ray Disc player.
- **Optical drive**: select the burning device from the drop down menu that you want to use to burn your disc.
- **TV format**: select the TV format (NTSC or PAL) for the region in which you would like to produce your movie. This format should correspond to the format of the region in which you plan to play your movie.
- **Video format**: displays the format of the video that will be burned to your disc. **MPEG-2**: standard definition format found on most DVD discs, and therefore takes up less space; **MPEG-4**: high definition video format, which requires more space when burning. A Blu-ray Disc player or AVCHD player is required to play back discs that contain this video format.

**Note**: For Blu-ray Discs you may select between the two formats, but for DVD and AVCHD it is set automatically.

- **Audio format**: select the desired audio encoding for your outputted disc’s audio.
- **Aspect ratio**: select the aspect ratio you want your video to be displayed on your disc.

**Note**: For DVDs you may select between 4-3 or 16-9, but for Blu-ray Disc and AVCHD it is set automatically to 16-9.
• **Quality**: select the video quality for your disc. The video quality settings offer different bit rates, resulting in files of different sizes. The higher the quality of the video, the larger the resulting file and the shorter the length of video that can fit onto a disc.

• **Disc capacity**: displays the available space on the disc currently inserted in the selected optical drive (burning device).

### Preferences

• **Display TV safe zone in the Preview window**: select to display a box when previewing your completed disc, which indicates the safe zone when creating the disc menu. Utilizing this feature ensures that menu items will be within the display range of most TVs.

• **Ask for the disc format when entering the Create Disc module**: select this option to be prompted to select a format for the disc every time you enter the Create Disc window. If you deselect this option, you will have to enter the Create Disc Preferences window to change the format of the disc.

• **Auto menu timeout - Menu display duration in seconds**: select this option for your burnt disc to play automatically after a selected duration. If this option is deselected, your disc will only begin playback if you manually select play on your disc player.
Chapter 5:

Preferences

This chapter outlines the preferences and configuration of specific features of CyberLink MediaShow, including e-mailing media, creating slideshows and screen savers and for the Library.

This chapter contains the following section:

- "MediaShow Preferences" on page 52
MediaShow Preferences

To open the Preferences, click on the MediaShow menu button and then select Preferences from the File menu.

General Preferences

The General Preferences tab lets you configure specific preferences for the CyberLink MediaShow program such as user interface language and set the default import folder.

- **Show tool tips**: select this option to display hints when your mouse hovers over certain features and buttons within the program.
- **User interface animation effects**: select this option to enable the animation effects within the program. You may want to deselect this option to improve computer performance, when required.
- **Language options**: select a the user interface language that you want to use within CyberLink MediaShow.
- **Launcher options**: select which images to dynamically display within the CyberLink MediaShow launcher.
- **Save imported photos and videos to**: set the default location where your imported media will be saved.

E-mail Preferences

The E-mail Preferences tab lets you set the output preferences when e-mailing your media.

- **Reduce size of large photos before e-mailing to**: use this option to change the resolution of photos that exceed the selected amount before e-mailing.
• **Reduce size of large videos before e-mailing to**: use this option to change the resolution of videos that exceed the selected amount before e-mailing.

**Slideshow Preferences**

The Slideshow Preferences tab lets you set the background music for your slideshow and also select your slideshow style.

**Slideshow style**

Select one of the following slideshow styles from the drop down menu:

- **Fading**: adds a fade in and fade out effect between the photos in your slideshow.
- **Motion**: adds pan and zoom effects to make your slideshow more engaging with the appearance of motion.
- **Cell**: selecting the cell slideshow will display your pictures in a creative, movie like slideshow, complete with credits. If you choose to include background music with your slideshow, CyberLink MediaShow uses the **Magic Slideshow** technology to display the photos dynamically along to the beat of the music.

**Background music**

- **Play music during slideshow (WMA/MP3)**: select this option to enable background music during the playback of a slideshow.

**Select folder or audio file for background music**

- Select an audio file or the folder that contains the music, in WMA or MP3 format, that you want to use for your slideshow Select a folder if you want to use multiple songs in your slideshow.

**Screen Saver Preferences**

You can set the background music for your screen saver and also set its style on the Screen Saver Preferences tab.

**Screen saver style**
Select one of the following screen saver styles from the drop down menu:

- **Fading**: adds a fade in and fade out effect between the photos in your screen saver.
- **Motion**: adds pan and zoom effects to make your screen saver more engaging with the appearance of motion.
- **Cell**: selecting the cell screen saver will display your pictures in a creative, movie like slideshow, complete with credits. If you choose to include background music with your screen saver, CyberLink MediaShow uses the Magic Slideshow technology to display the photos dynamically along to the beat of the music.

**Background music**

- **Play music during screen saver (WMA/MP3)**: select this option to enable background music during the playback of a screen saver.

**Select folder or audio file for background music**

- Select an audio file or the folder that contains the music, in WMA or MP3 format, that you want to use for your screen saver. Select a folder if you want to use multiple songs in your screen saver.

**Library Preferences**

The Library Preferences tab lets you add folders that contain your media to CyberLink MediaShow. When you add a folder, it will be scanned for new media automatically every time you launch the program.

**Note**: You may also access the Library Preferences tab by selecting Add Folder to MediaShow from the File menu.

- click on the + button to add folders to CyberLink MediaShow. CyberLink MediaShow scans the folders in the list every time the program is launched and automatically loads all of the new media into the Library.
Chapter 5: Preferences

Import options

- **Ignore photo files less than 50 KB**: select this option if you do not want to import photo files that are less than 50 KB in size.
- **Ignore video files less than 500 KB**: select this option if you do not want to import video files that are less than 500 KB in size.
CyberLink MediaShow
Chapter 6:

Technical Support

This chapter contains technical support information. It includes all the information to find the answers you need to assist you. You may also find answers quickly by contacting your local distributor/dealer.

This chapter contains the following sections:

- "Before Contacting Technical Support" on page 58
- "Web Support" on page 59
Before Contacting Technical Support

Please take advantage of one of CyberLink’s free technical support options:

• consult the User Guide or the online help installed with your program.
• refer to the Frequently Asked Questions (FAQs) in the Support section of the CyberLink Web site.

http://www.cyberlink.com/multi/support/product_faq_home.jsp

The FAQs may have information and helpful hints that are more current than the User Guide and online help.

When contacting technical support by email or phone, please have the following information ready:

• registered Activation Key (Your Activation Key can be found on the CD cover, the Box cover, or in the email received after you purchased CyberLink products on the Cyberlink store.)
• the product name, version and build number, which generally can be found by clicking on the product name image on the user interface
• the version of Windows installed on your system
• hardware devices on your system (capture card, sound card, VGA card) and their specifications
• the wording of any warning messages that were displayed (You may want to write this down or take a screen capture)
• a detailed description of the problem and under what circumstances it occurred
Web Support

Solutions to your problems are available 24 hours a day at no cost on the CyberLink web sites:

**Note:** You must first register as a member before using CyberLink web support.

CyberLink provides a wide range of web support options, including FAQs and a user community forum, in the following languages:

<table>
<thead>
<tr>
<th>Language</th>
<th>Web Support URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td><a href="http://www.cyberlink.com/CS/support/enu/support_index.jsp">http://www.cyberlink.com/CS/support/enu/support_index.jsp</a></td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td><a href="http://tw.cyberlink.com/CS/support/cht/support_index.jsp">http://tw.cyberlink.com/CS/support/cht/support_index.jsp</a></td>
</tr>
<tr>
<td>Japanese</td>
<td><a href="http://jp.cyberlink.com/jpn/support_jpn/support_index.jsp">http://jp.cyberlink.com/jpn/support_jpn/support_index.jsp</a></td>
</tr>
<tr>
<td>Italian</td>
<td><a href="http://it.cyberlink.com/CS/support/ita/support_index.jsp">http://it.cyberlink.com/CS/support/ita/support_index.jsp</a></td>
</tr>
<tr>
<td>German</td>
<td><a href="http://de.cyberlink.com/CS/support/deu/support_index.jsp">http://de.cyberlink.com/CS/support/deu/support_index.jsp</a></td>
</tr>
<tr>
<td>French</td>
<td><a href="http://fr.cyberlink.com/CS/support/fra/support_index.jsp">http://fr.cyberlink.com/CS/support/fra/support_index.jsp</a></td>
</tr>
<tr>
<td>Spanish</td>
<td><a href="http://es.cyberlink.com/CS/support/esp/support_index.jsp">http://es.cyberlink.com/CS/support/esp/support_index.jsp</a></td>
</tr>
</tbody>
</table>
Index

A

Add folder to Library 54
Albums
  add media 5
  create 5
  overview 5
  tools 5
Antique 21
Aspect ratio 48
Audio
  reduce background noise 36
  select format 48

B

Background music 47
  screen saver setting 54
  slideshow setting 53
Balance, auto 20
Batch edit, photos 22
Black & white 21
Brightness
  auto 20
  fine tune photos 21
  fine tune videos 36

C

Captions
  set type 11
  show in slideshow 18
  show in video 33
Cell 47, 53
Compare 19
Contrast
  auto 20
  fine tune photos 21
  fine tune videos 36
Controls
  slideshow 17
  videos 33
Create
  disc 44
  movies 38
  new album 5
  new tag 7
  screen saver 25
  slideshow movie 26
Crop 20

D

Description
  edit photo 22
  edit video 37
Disc
add photos 46
add videos 46
aspect ratio 48
burn 47
capacity 49
create 44
format 48
menus 46
photo 27
style 46
title 45
TV format 48
video 40
Display hidden 11

E

Edit
batch 22
fix photos 20
fix videos 36
photo description 22
photos 19
rotate photos 20
rotate videos 35
trim videos 36
video description 37
videos 35
Effects, photos 21
E-mail
photos 28
preferences 52
reduce photo size 52
reduce video size 53
videos 41

F

Fading 47, 53
Favorites
add/remove media 10
albums 5
overview 10
Fine tune, photos 21, 36
Fix
photos 20
shaky video 36
videos 36
Fix lighting
photos-auto 20
videos-auto 36
Flickr 28
Focal B&W 21
Folders
create 6
hide 11
move to new folder 6
overview 5
separate by date 6
separate folder here 6
show 11
tools 6
Function buttons 3

G

Glow 21
I
Import
  media 7
  set folder 52

L
Language
  set user interface 52
Launcher options 52
Library
  add folder to 54
  import media 7
  overview 4
  preferences 54
  search 10

M
Magic slideshow 53
Main features 2
Matte 21
Media
  hide 11
  photos-create 25
  resize 9
  search for 10
  show 11
  videos-create 38
Media window
  overview 9
  resize thumbnails 9

Motion 47, 53

N
NTSC 48

O
Optical drive 48
Order prints 24

P
PAL 48
Photos
  add to disc 46
  auto balance 20
  auto brightness 20
  auto contrast 20
  auto fix lighting 20
  batch edit 22
  compare 19
  create a disc 27
  create slideshow 17
  crop 20
  edit 19
  edit description 22
  effects 21
  e-mail 28
  fine tune 21
  fix 20
  hide 11
order prints 24
printing 23
red-eye 20
reduce size 52
resize thumbnails 9
rotate 20
screen saver 25
search for 10
set as background 25
set import folder 52
share 28
show 11
slideshow movie 26
straighten 20
upload 28
view 16
Play back
  slideshow 17
  videos 33
Preferences
  cell 53
  e-mail 52
  fading 53
  general 52
  library 54
  motion 53
  screen saver 53
  slideshow 53
Print 23

R

Red-eye 20
Resize thumbnails 9
Rotate left 20, 35
Rotate right 20, 35

S

Saturation
  fine tune photos 21
  fine tune videos 36
Screen saver
  background music 54
  create 25
  preferences 53
  selecting style 53
  style description 53
Search media 10
Sepia 21
Settings 51
  burning 48
  Create Disc 48
  create movie 39
Share
  photos 28
  videos 41
Sharpness, fine tune photos 21
Show captions 18, 33
Show tool tips 52
Skin color 11
Slideshow
  background music 47, 53
  cell 47
  controls 17

Q

Quality 49
Index

create 17
fading 47
magic slideshow 53
motion 47
preferences 53
selecting style 47, 53
show captions 18
speed 47
style description 47, 53
Slideshow movie, create 26
Soft focus 21
Straighten 20
System requirements 12

T

Tags
  create 7
  overview 6
  tools 6
Thumbnails
  resize thumbnails 9
  size 11
Tint 21
Tray, overview 10
Trim 36
TV format 48
TV safe zone 49

U

Upload
  videos 41
Upload photos 28

User interface
  animation effects 52
  language 52
  select color 11

V

Video
  format 48
Videos
  add to disc 46
  auto fix lighting 36
  create a disc 40
  create movies 38
  edit 35
  edit description 37
  e-mail 41
  fix 36
  fix shaky video 36
  hide 11
  playback controls 33
  reduce background noise 36
  reduce size 53
  resize thumbnails 9
  rotate 35
  search for 10
  set import folder 52
  share 41
  show 11
  show captions 33
  upload 41
  watch 32

View
  captions 11
  display hidden 11
  skin 11
CyberLink MediaShow

thumbnails 11
Vignette 21

W
White balance
  fine tune photos 21
  fine tune videos 36

Y
YouTube 41